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Garantie 2
Tektronix garantiert, dass dieses Produkt für einen Zeitraum von einem (1) Jahr ab Versanddatum keine Fehler in Material und
Verarbeitung aufweist. Wenn ein Produkt innerhalb dieser Garantiezeit Fehler aufweist, steht es Tektronix frei, dieses fehlerhafte
Produkt kostenlos zu reparieren oder einen Ersatz für dieses fehlerhafte Produkt zur Verfügung zu stellen. Von Tektronix für
Garantiezwecke verwendete Teile, Module und Ersatzprodukte können neu oder in ihrer Leistung neuwertig sein. Alle ersetzten
Teile, Module und Produkte werden Eigentum von Tektronix.

Um mit dieser Garantie Kundendienst zu erhalten, muss der Kunde Tektronix über den Fehler vor Ablauf der Garantiezeit informieren
und geeignete Vorkehrungen für die Durchführung des Kundendienstes treffen. Der Kunde ist für die Verpackung und den Versand
des fehlerhaften Produkts an die Service-Stelle von Tektronix verantwortlich, die Versandgebühren müssen im Voraus bezahlt sein.
Tektronix übernimmt die Kosten der Rücksendung des Produkts an den Kunden, wenn sich die Versandadresse innerhalb des Landes
der Tektronix Service-Stelle befindet. Der Kunde übernimmt alle Versandkosten, Fracht- und Zollgebühren sowie sonstige Kosten
für die Rücksendung des Produkts an eine andere Adresse.

Diese Garantie tritt nicht in Kraft, wenn Fehler, Versagen oder Schaden auf die falsche Verwendung oder unsachgemäße und falsche
Wartung oder Pflege zurückzuführen sind. Tektronix muss keinen Kundendienst leisten, wenn a) ein Schaden behoben werden
soll, der durch die Installation, Reparatur oder Wartung des Produkts von anderem Personal als Tektronix-Vertretern verursacht
wurde; b) ein Schaden behoben werden soll, der auf die unsachgemäße Verwendung oder den Anschluss an inkompatible Geräte
zurückzuführen ist; c) Schäden oder Fehler behoben werden sollen, die auf die Verwendung von Komponenten zurückzuführen sind,
die nicht von Tektronix stammen; oder d) wenn ein Produkt gewartet werden soll, an dem Änderungen vorgenommen wurden oder
das in andere Produkte integriert wurde, so dass dadurch die aufzuwendende Zeit für den Kundendienst oder die Schwierigkeit der
Produktwartung erhöht wird.

DIESE GARANTIE WIRD VON TEKTRONIX FÜR DAS PRODUKT ANSTELLE ANDERER AUSDRÜCKLICHER ODER IMPLIZITER
GARANTIEN GEGEBEN. TEKTRONIX UND SEINE HÄNDLER SCHLIESSEN AUSDRÜCKLICH ALLE GARANTIEN HINSICHTLICH
DER HANDELSGÄNGIGKEIT UND DER EIGNUNG FÜR EINEN BESTIMMTEN ZWECK AUS. FÜR TEKTRONIX BESTEHT DIE
EINZIGE UND AUSSCHLIESSLICHE VERPFLICHTUNG DIESER GARANTIE DARIN, FEHLERHAFTE PRODUKTE FÜR DEN
KUNDEN ZU REPARIEREN ODER ZU ERSETZEN. TEKTRONIX UND SEINE HÄNDLER ÜBERNEHMEN KEINERLEI HAFTUNG
FÜR DIREKTE, INDIREKTE, BESONDERE UND FOLGESCHÄDEN, UNABHÄNGIG DAVON, OB TEKTRONIX ODER DER
HÄNDLER VON DER MÖGLICHKEIT SOLCHER SCHÄDEN IM VORAUS UNTERRICHTET IST.
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Allgemeine Sicherheitshinweise

Allgemeine Sicherheitshinweise
Beachten Sie zum Schutz vor Verletzungen und zur Verhinderung von Schäden an diesem Gerät oder an damit verbundenen
Geräten die folgenden Sicherheitshinweise.

Verwenden Sie dieses Gerät nur gemäß der Spezifikation, um jede mögliche Gefährdung auszuschließen.

Wartungsarbeiten sind nur von qualifiziertem Personal durchzuführen.

Während der Verwendung des Geräts müssen Sie eventuell auf andere Teile eines umfassenderen Systems zugreifen.
Beachten Sie die Sicherheitsangaben in Handbüchern für andere Komponenten bezüglich Warn- und Vorsichtshinweisen
zum Betrieb des Systems.

Verhütung von Bränden und Verletzungen
Verwenden Sie ein ordnungsgemäßes Netzkabel. Verwenden Sie nur das mit diesem Produkt ausgelieferte und
für das Einsatzland zugelassene Netzkabel.

Schließen Sie das Gerät ordnungsgemäß an. Trennen oder schließen Sie keine Tastköpfe oder Prüfleitungen
an, während diese an einer Spannungsquelle anliegen.

Schließen Sie das Gerät ordnungsgemäß an. Unterbinden Sie die Stromzufuhr für den Messpunkt, bevor Sie den
Tastkopf anschließen oder vom Gerät trennen.

Erden Sie das Produkt. Das Gerät ist über den Netzkabelschutzleiter geerdet. Zur Verhinderung von Stromschlägen
muss der Schutzleiter mit der Stromnetzerdung verbunden sein. Vergewissern Sie sich, dass eine geeignete Erdung besteht,
bevor Sie Verbindungen zu den Eingangs- oder Ausgangsanschlüssen des Geräts herstellen.

Beachten Sie alle Angaben zu den Anschlüssen. Beachten Sie zur Verhütung von Bränden oder Stromschlägen
die Kenndatenangaben und Kennzeichnungen am Gerät. Lesen Sie die entsprechenden Angaben im Gerätehandbuch,
bevor Sie das Gerät anschließen.

Die Eingänge sind nicht für Anschlüsse an Hauptstromkreise oder Schaltkreise der Kategorien II, III und IV ausgelegt.

Schließen Sie einen Tastkopf nicht an eine Leitung an, deren Spannung die Nennspannung des Tastkopfes überschreitet.

Trennen vom Stromnetz. Der Netzschalter trennt das Gerät von der Stromversorgung. Weitere Anweisungen zur
Positionierung des Schalters finden Sie in der Dokumentation. Blockieren Sie den Netzschalter nicht, da er für die Benutzer
jederzeit zugänglich sein muss.

Schließen Sie die Abdeckungen. Nehmen Sie das Gerät nicht in Betrieb, wenn Abdeckungen oder Gehäuseteile
entfernt sind.

Bei Verdacht auf Funktionsfehler nicht betreiben. Wenn Sie vermuten, dass das Gerät beschädigt ist, lassen
Sie es von qualifiziertem Wartungspersonal überprüfen.

Vermeiden Sie offen liegende Kabel. Berühren Sie keine freiliegenden Anschlüsse oder Bauteile, wenn diese unter
Spannung stehen.

Verwenden Sie die richtige Sicherung. Verwenden Sie nur Sicherungen des für dieses Gerät angegebenen Typs.
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Nicht bei hoher Feuchtigkeit oder Nässe betreiben.

Nicht in Arbeitsumgebung mit Explosionsgefahr betreiben.

Sorgen Sie für saubere und trockene Produktoberflächen.
Sorgen Sie für die richtige Kühlung. Weitere Informationen über die Gewährleistung einer ordnungsgemäßen Kühlung
für das Produkt erhalten Sie im Handbuch.

Begriffe in diesem Handbuch
In diesem Handbuch werden die folgenden Begriffe verwendet:

WARNUNG. Warnungen weisen auf Bedingungen oder Verfahrensweisen hin, die eine Verletzungs- oder Lebensgefahr
darstellen.

VORSICH. Vorsichtshinweise machen auf Bedingungen oder Verfahrensweisen aufmerksam, die zu Schäden am Gerät
oder zu sonstigen Sachschäden führen können.

Symbole und Begriffe am Gerät
Am Gerät sind eventuell die folgenden Begriffe zu sehen:

GEFAHR weist auf eine Verletzungsgefahr hin, die mit der entsprechenden Hinweisstelle unmittelbar in Verbindung steht.

WARNUNG weist auf eine Verletzungsgefahr hin, die nicht unmittelbar mit der entsprechenden Hinweisstelle in
Verbindung steht.

VORSICHT weist auf mögliche Sach- oder Geräteschäden hin.

Am Gerät sind eventuell die folgenden Symbole zu sehen:
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Vorwort
In diesem Handbuch werden die Installation und die Bedienungsgrundlagen des automatischen Videomesssystems VM5000
beschrieben. Weitere Informationen finden Sie in der Online-Hilfe für das Gerät und im Benutzerhandbuch für das
automatische Videomesssystem VM5000.

Hauptfunktionen
Das automatische Videomesssystem VM5000 ist ein auf einer Oszilloskopplattform basierendes
Hochleistungs-Videomesssystem. Es weist die folgenden Hauptfunktionen auf:

Schnelle, genaue und verlässliche Videomessungen

Umfassende Analyse für analoge Komponentensignale

Automatische Prüfung von PC- und DTV-Heimvideogeräten

Automatische VESA-Komformitätsprüfung für PC-Grafikgeräte

Unterstützt analoge SD-, HDTV- und RGBHV-Videoformate über Optionen

Bild-, Vektor- und Signalanzeige

Integrierte Pass/Fehler-Grenzwertprüfung

Handbuch für Prüfsignalpakete

GPIB-Fernsteuerung und LAN-Anschluss

Umfassende Oszilloskopfunktionalität

Dokumentation

Informationen Dokumente
Installation und Betrieb (Übersicht) Schnellstart-Benutzerhandbuch für das automatische Videomesssys-

tem VM5000 Das Schnellstart-Benutzerhandbuch enthält allgemeine
Informationen über die Inbetriebnahme des Geräts, einen Leitfaden für
Benutzeroberflächen-Steuerelemente sowie Anwendungsbeispiele.

Ausführliche Hilfe für den Betrieb und die
Benutzeroberfläche

Benutzerhandbuch für das automatische Videomesssystem VM5000 Das
Benutzerhandbuch enthält ausführliche Informationen über den Betrieb
des Geräts, einschließlich der Berechnung von Messungen und der
Spezifikationen.
Online-Hilfe für VM5000. Greifen Sie mit Hilfe des Hilfemenüs der
VM5000-Software auf die Online-Hilfe zu, um Informationen zu den
Bedienelementen und Elementen auf dem Bildschirm zu erhalten.

Programmierbefehle Programmierhandbuch für das automatische Videomesssystem VM5000
Die speziell für VM5000 geltenden Programmierbefehle sind in einer
PDF-Datei auf der VM5000-Produktsoftware-CD aufgeführt. Das
Programmierhandbuch für TDS5000B ist eine PDF-Datei auf der
TDS5000B-Produktsoftware-CD.
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Vorwort

Informationen Dokumente
Einsatz des Oszilloskops Vollständige Informationen zur Verwendung der Oszilloskopfunktionen des

VM5000 finden Sie in der TDS5000B-Dokumentation.
Benutzerservice und Leistungsprüfung Informationen finden Sie im Wartungshandbuch für die Serie TDS5000B.

Softwareaktualisierungen
Gelegentlich können Softwareaktualisierungen verfügbar gemacht werden. Die Software kann nur in Verbindung mit einem
gültigen Optionsschlüssel für das jeweilige Oszilloskopmodell und die betreffende Seriennummer verwendet werden.

So suchen Sie nach Aktualisierungen:

1. Navigieren Sie zur Tektronix-Website (www.tektronix.com).

2. Wählen Sie Software and Drivers (Software und Treiber) aus, um die Webseite Software and Firmware Finder
(Software- und Firmware-Suche) aufzurufen.

3. Geben Sie den Produktnamen (VM5000) ein, um nach verfügbaren Softwareaktualisierungen zu suchen.

In diesem Handbuch verwendete Konventionen
In diesem Handbuch wird der Umgang mit den Optionen SD, HD und VGA beschrieben. Obwohl die Betriebsverfahren
für alle drei Optionen identisch sind, gibt es einige Unterschiede hinsichtlich der Funktionen, vor allem bezüglich der
verfügbaren Messungen. Unterschiede in der Konfiguration bzw. in der Anwendung werden im Text durch die Option
kenntlich gemacht, für die sie gelten. Bei Unterschieden in der Bildschirmanzeige werden beide Versionen angezeigt
(Option SD/HD und Option VGA).

Die folgenden Symbole werden in diesem Handbuch verwendet.

Verfahrenss-
chritt

Netzschalter
auf der
Frontplatte

Netzan-
schluss

Netzwerk PS2 SVGA USB
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Installation des Geräts
Dieser Abschnitt enthält Informationen zur Installation des Geräts und zum Umgang mit dem Gerät.

Auspacken des Geräts
Packen Sie das Gerät vorsichtig aus, und vergewissern Sie sich, dass das Standardzubehör enthalten ist.

Standardzubehör für VM5000
Zubehör Teilenummer
Schnellstart-Benutzerhandbuch für das automatische Videomesssystem VM5000 in englischer,
französischer, deutscher, spanischer, chinesischer (traditionell oder vereinfacht) oder
japanischer Übersetzung, wenn eine der Sprachoptionen bestellt wurde.

071-1573-XX

Benutzerhandbuch für das automatische Videomesssystem VM5000 071-1522-XX
Programmierhandbuch für das automatische Videomesssystem VM5000 im PDF-Format auf
der VM5000-Produktsoftware-CD

071-1574-XX

DVD-Signalsystem VM5000 (nur für Option SD) 020-2610-XX
VM5000 MPEG- und Basisband-Signalsystem (nur für Option SD/HD) 020-2611-XX
VM5000 PC-Bitmapgrafik-Prüfsignaldateien (nur für Option VGA) 020-2634-XX
Schnellstart-Benutzerhandbuch für Digital-Phosphor-Oszilloskope der Serie TDS5000B 071-1355-XX
Das Handbuch Einstieg in Oszilloskopanalyse und -anschluss mit der dazugehörigen Software 020-2449-XX
CD-ROM Produktsoftware für VM5000 mit der darin enthaltenen Produktsoftware
und Online-Hilfe für VM5000, Benutzerhandbuch für VM5000 als PDF-Version,
Schnellstart-Benutzerhandbuch für VM5000 als PDF-Version und Versionsinformationen

020-2565-XX

CD-ROM Produktsoftware für die Serie TDS5000B mit der darin enthaltenen Produktsoftware
und Online-Hilfe für Produkte der Serie TDS5000B, Programmieranleitung für
TDS5000B (GPIB-Online-Hilfe und PDF-Version), Leistungsprüfung als PDF-Version,
Versionsinformationen und VISA-Informationen

063-3692-XX

CD-ROM Betriebssystemwiederherstellung für die Serie TDS5000B 063-3579-XX
CD-ROM Optionale Anwendungssoftware für die Serie TDS5000B 020-2450-XX
P5050 10X, 500 MHz, Passiver Spannungstastkopf P5050
Buch Erste Schritte mit OpenChoice ™ und Software Developer’s Kit auf CD-ROM 020-2513-XX
LabVIEW-Testexemplar für einen Zeitraum von 30 Tagen 020-2476-XX
Kalibrierungszertifikat zur Dokumentation der NIST-Rückfahrbarkeit, Z540-1-Konformität und
ISO9001-Registrierung

— —

US-Netzkabel 161-0104-00
Maus 119-6936-XX
Minitastatur 118-9402-XX
Frontschutzdeckel 200-4651-XX
Zubehörtasche 016-1935-XX
Leere CDR/CDRW 020-2434-XX
Click’N Burn-CD 063-3575-XX
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Standardzubehör für VM5000 (Fortsetzung)

Zubehör Teilenummer
75-Ohm-Präzisionsabschlüsse (4) 011-0102-XX
BNC-Verbinder (Buchse an Buchse) 103-0028-XX
BNC-Verbinder (Stecker an Stecker) 103-0029-XX
BNC-T-Verbinder (4) 103-0030-XX
Sync-Pickoff-Kabel (nur für Option SD/HD) 012-1680-XX
VGA-zu-5X BNC-Kabel (12,7 cm lang) (nur für Option VGA) 174-5147-XX
VGA-zu-5X BNC-Kabel (91,4 cm lang) (Nur für Option VGA) 174-5126-XX
RGBHV-Messschnittstelleneinheit (nur für Option VGA) 012-1685-XX
Steuerkabel RS-232 RGBHV MIU (nur für Option VGA) 012-1692-XX
BNC-to-Binding-Post-Adapter (2) (Nur für Option VGA) 011-0183-00
2,21-Kiloohm-Widerstand 322-3226-00
301-Ohm-Widerstand 322-3143-00
VGA Sync Combiner-Kabel 012-1664-XX

Das Gerät kann auch optionales Zubehör enthalten. Überprüfen Sie, ob das von Ihnen bestellte optionale Zubehör dem
Gerät beigefügt ist.

Empfohlenes Zubehör für VM5000 1

Zubehör Teilenummer
Wartungshandbuch für Digital-Phosphor-Oszilloskope der Serie TDS5000B 071-1362-XX
Transportkoffer 016-1937-XX
Tastkopfkalibrierungs-, Kompensations- und Versatzausgleichadapter 067-0405-XX
Vorrichtung für den Stromversatzausgleich 067-1478-00
Video-Anzeigeklemme 013-0278-XX
Passiver Tastkopf P5050 500 MHz 10x P5050
GPIB-Kabel (1 m) 012-0991-01
GPIB-Kabel (2 m) 012-0991-00
Centronics-Kabel (Drucker) 012-1214-00
1 Auf unserer Website unter www.tektronix.com finden Sie eine aktuelle Liste mit Zubehör, Aktualisierungen und Optionen, einschließlich der für

Ihr VM5000-Produkt verfügbaren Serviceoptionen.
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Betriebsvoraussetzungen
1. Stellen Sie das Gerät auf einem

Rollwagen oder einen Labortisch,
und beachten Sie die erforderlichen
Abstände:

Oberseite, Rückseite, Vorderseite
und rechte Seite 0 mm

Linke Seite: 76 mm

Unten: 19 mm oder 0 mm
mindestens bei Fußaufstellung,
Stand heruntergeklappt

2. Stellen Sie vor dem Betrieb sicher, dass
die Umgebungstemperatur zwischen
+5°C und +45°C liegt.

VORSICH. Halten Sie die Unterseite und die Seiten des Geräts frei, um die erforderliche Kühlung zu gewährleisten.

Einschalten des Geräts
Stromversorgung - Voraussetzungen
Stromspannung und -frequenz Stromverbrauch
100-240 Veff ±10%, 47-63 Hz oder 115 Veff ±10%,
360-440 Hz

< 220 Watt
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Ausschalten des Geräts

Abziehen des Netzkabels

Verbindung zu einem Netzwerk herstellen
Das Anschließen des Geräts an ein
Netzwerk ermöglicht u. a. das Drucken, das
gemeinsame Nutzen von Dateien und den
Zugriff auf das Internet. Wenden Sie sich an
Ihren Netzwerkadministrator, und verwenden
Sie die Windows-Standardprogramme, um
das Gerät für Ihr Netzwerk zu konfigurieren.
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Erstellen einer Notfall-Startdiskette
Erstellen Sie eine Notfall-Startdiskette, mit der Sie das Gerät im Falle eines gravierenden Hardware- oder Softwarefehlers
neu starten können. Bewahren Sie die Diskette an einem sicheren Ort auf.

1. Wenn die TekScope-Software ausgeführt
wird, wählen Sie File > Minimize (Datei
> Minimieren) aus.

2. Wählen Sie Start > Programs >
Accessories > System Tools > Backup
(Start > Programme > Zubehör >
Systemprogramme > Sicherung) aus.

3. Wählen Sie Emergency Repair Disk
(Notfalldiskette) aus, und folgen Sie den
Anweisungen auf dem Bildschirm.
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Umgang mit dem Gerät

Vorderseite

Seitenplatten und Rückplatte
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Voraussetzungen für Eingangsverbindungen – Optionen SD/HD
Verwenden Sie nur 75-Ohm-Koaxialkabel, um den Videoprüfling an das VM5000-Gerät anzuschließen.

Installieren Sie die beiliegenden
75-Ohm-Abschlüsse mit Hilfe
der BNC-T-Verbinder zwischen
den Koaxialkabeln und den
Geräteingangskanälen. Um genaue
Frequenzgangmessungen zu erreichen, ist
es unerlässlich, die T-Verbinder direkt an die
Eingangskanal-BNCs anzuschließen.

Voraussetzungen für Eingangsverbindungen – Option VGA
Die bevorzugte Methode zum Anschließen
eines Videoprüflings an ein VM5000-Gerät
besteht in der Verwendung der
RGBHV-Messschnittstelleneinheit.
Die Messschnittstelleneinheit enthält
eine impedanzangepasste Schaltung und
gewährleistet so genaue Messergebnisse.
Für einige Messungen wird ein
Niederfrequenzpfad verwendet, für
andere Messungen hingegen wird ein
Breitbandpfad verwendet. VM5000
wählt den zu verwendenden Pfad
über eine RS-232-Verbindung mit der
Messschnittstelleneinheit (MIU) aus.

Sie können den Videoprüfling
auch mit Hilfe des mitgelieferten
VGA-Anschluss-zu-5X-Kabels an VM5000
anschließen. Wenn Sie sich für dieses
Verfahren entscheiden, wird das Kabel mit
Hilfe der gelieferten Präzisionsabschlüsse
an das VM5000-Gerät angeschlossen, und
möglicherweise müssen Sie die Abschlüsse
während der Messungen manuell ändern,
je nachdem, welche Messungen ausgeführt
werden sollen.
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Verbinden von Eingangssignalen
Setup 1 für Option SD/HD
Setup 1 ist das bevorzugte Setup zum Überprüfen analoger Videokomponentensignale (Y/G, Pb/B, Pr/R) für dreiadrige
Kabel mit Composite-Sync-Signal auf Y/G. Dieses Setup leitet das Triggersignal mit Hilfe des Sync-Pickoff-Zubehörs
aus dem Y/G-Signal auf CH1 ab. Die Triggerquelle ist auf Kanal 4 festgelegt. Diese Konfiguration ermöglicht genauere
rauscharme Messungen (unter -60 dB bei einer Bandbreite von 30 MHz) als Setup 2.

Durch diese Verbindungsart wird während der Triggerung auf CH4 eine genauere Rauschmessung auf CH1 ermöglicht,
ohne dass eine zusätzliche Verkabelung zwischen CH1 und CH4 erforderlich ist. Die zusätzliche Verkabelung kann den
Frequenzgang beeinträchtigen und zu Mehrfachbursts bei Messungen führen.

Um den besten Frequenzgang und Mehrfachburst-Messungen zu erreichen, muss der 75-Ohm-Abschluss so nah wie
möglich an den Eingangsanschluss angeschlossen sein, wie in der Setup-Abbildung dargestellt.

8 Schnellstart-Benutzerhandbuch für VM5000



Umgang mit dem Gerät

Die folgende Abbildung veranschaulicht, wie das Sync-Pickoff an den CH1-Eingang angeschlossen wird.

HINWEIS. Stellen Sie sicher, dass der Triggerkanal auf Kanal 4 festgelegt ist (Standardeinstellung). Wenn die
Triggereinstellung („Configuration > Operation“) (Konfiguration > Betrieb) nicht auf CH4 festgelegt ist, werden
Signalwarnmeldungen angezeigt, und es können keine Messungen ausgeführt werden.

Setup 2 für Option SD/HD – Dreiadriges Analogvideokabel mit Composite-Sync
Dieses Setup kann verwendet werden, um Analogvideosignale (Y/G, Pb/B, Pr/R) für dreiadrige Kabel mit
dem Composite-Sync-Signal auf Y/G zu prüfen. Legen Sie die Triggerung für das Gerät auf Kanal 1 fest (die
Triggerstandardeinstellung ist CH4). Dieses Setup ist einfacher als die anderen in diesem Kapitel erwähnten, es beschränkt
jedoch die Rauschmessung auf Y/G bis -65 dB (30 MHz Rauschbandbreite).

Schnellstart-Benutzerhandbuch für VM5000 9



Umgang mit dem Gerät

Setup 3 für Option SD/HD – Dreiadriges Analogvideokabel mit separater Composite-Sync
Verwenden Sie dieses Setup zum Prüfen analoger Videokomponentensignale (Y/G, Pb/B, Pr/R) für vieradrige Kabel
mit dem Composite-Sync-Signal an einem separaten Ausgang. Für CH4 können Sie das Signal ohne einen Abschluss
anschließen, oder Sie können einen 75-Ohm-Abschluss verwenden, der weniger präzise ist als die mit dem Gerät gelieferten
75-Ohm-Abschlüsse.

HINWEIS. Stellen Sie sicher, dass der Triggerkanal auf Kanal 4 festgelegt ist (Standardtriggerkanal). Wenn die
Triggereinstellung nicht auf CH4 („Configuration > Operation“) (Konfiguration > Operation) festgelegt ist, werden
Signalwarnmeldungen angezeigt, und es können keine Messungen ausgeführt werden.
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Setup 1 für Option VGA – RGBHV-Messschnittstelleneinheit
Dies ist das bevorzugte Setup zum Prüfen von PCs und Videogeräten. Verwenden Sie die RGBHV-Messschnittstelleneinheit,
um die PC-Videokarte an das VM5000-Gerät anzuschließen. Bei Verwendung der RGBHV-Messschnittstelleneinheit
werden die genauesten Messergebnisse erzielt.

So schließen Sie die RGBHV-Messschnittstelleneinheit an:

1. Schließen Sie den Prüfling mit Hilfe
eines der mit dem VM5000-Gerät
gelieferten VGA-zu-BNC-Adapterkabel
an den Eingang der
RGBHV-Messschnittstelleneinheit
an.
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2. Schließen Sie die Ausgänge
(AUX, CH1–CH4) der
RGBHV-Messschnittstelleneinheit
an die entsprechenden Ausgänge am
VM5000-Gerät an (d. h. CH1-Ausgang
an CH1-Eingang).

3. Schließen Sie das RS-232-Kabel
zwischen der RGBHV-
Messschnittstelleneinheit und dem
COM1-Anschluss am VM5000-Gerät an.

4. Überprüfen Sie, ob auf der Registerkarte
„Configuration > Operations“
(Konfiguration > Operationen)
das Kontrollkästchen Use MIU
(Messschnittstelleneinheit verwenden)
aktiviert ist.
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Setup 2 für Option VGA – VGA-Anschluss an 5X-Kabel
Verwenden Sie dieses Setup zum Prüfen von PCs und Videogeräten, wenn sich die RGBHV-Messschnittstelleneinheit nicht
dazu eignet. Um sicherzustellen, dass die Messungen genau sind, schließen Sie das VM5000-Gerät an die T-Verbinder und
Präzisionsanschlüsse an CH1-CH4 an. Sie müssen den 75-Ohm-Abschluss an CH1-CH3 (verwendet für GBR) und den
2,21-Kiloohm- sowie den 301-Ohm-Abschluss an CH4 verwenden (verwendet für H Sync- und V Sync-Messungen). Diese
Methode erfordert, dass die Signal- und Abschlussanschlüsse an CH4 für bestimmte horizontale und vertikale Messungen
geändert werden. Das VM5000-Gerät zeigt ein Dialogfeld an, in dem Sie dazu aufgefordert werden, diese Änderungen ggf.
vorzunehmen (die RGBHV-Messschnittstelleneinheit führt diese Anschluss- und Abschlussänderungen intern durch).

So schließen Sie einen Prüfling mit Hilfe eines VGA-zu-5x-Kabels an das VM5000-Gerät an:

1. Installieren Sie die beiliegenden
75-Ohm-Abschlüsse mit Hilfe
der BNC-T-Verbinder zwischen
den BNC-Kabeln und den
Geräteingangskanälen 1 bis 3.
Um präzise Messungen zu erreichen,
ist es unerlässlich, die T-Verbinder
direkt an die Eingangskanal-BNCs
anzuschließen.

2. Bei der Ausführung von H Sync-,
V Sync- oder V Timing-Messungen sind
2,21-Kiloohm- und 301-Ohm-Abschlüsse
erforderlich. Dazu werden die
als Standardzubehör gelieferten
BNC-to-Binding-Post-Adapter und
-Widerstände benötigt. Schließen Sie
jeden Widerstand an einen Adapter an,
wie in der Abbildung dargestellt.
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3. Legen Sie die VGA-Signale
entsprechend der Abbildung an
das VM5000-Gerät an. Schließen Sie
zunächst das H Sync-Signal mit Hilfe
des 2,21-Kiloohm-Abschlusses an. Das
VM5000-Gerät fordert Sie ggf. auf, den
301-Ohm-Abschluss zu verwenden.

In einer Popupwarnung werden Sie
beim Ausführen einer H Sync-Messung
aufgefordert, den Signalabschluss auf CH4
zu ändern.

In der folgenden Tabelle ist dargestellt, welches Signal vom Prüfling an welchen VM5000-Eingang angeschlossen werden
soll und welcher Abschluss für die einzelnen Signale verwendet werden muss.

VGA-Signal VM5000-Eingang Abschluss
Grün CH 1 75 Ohm
Blau CH 2 75 Ohm
Rot CH 3 75 Ohm
H Sync CH 4 1 2,21 Kiloohm und 301 Ohm
V Sync AUX Kein
1 Das V Sync-Signal ist bei der Durchführung von V Timing- und V Sync-Messungen an diesen Kanal angeschlossen. Das VM5000-Gerät fordert Sie

ggf. auf, diesen Anschluss zu verwenden.
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Signalpfadkompensation
Verwenden Sie dieses Verfahren, wenn sich die Temperatur seit der letzten Signalpfadkompensation um mehr als 5 °C
geändert hat. Führen Sie die Signalpfadkompensation einmal pro Woche aus. Wenn Sie dies unterlassen, kann das Gerät
möglicherweise die garantierte Leistungsstufe bei diesen Volts-/Div-Einstellungen nicht erreichen.

1. Voraussetzungen: Das Gerät ist über
20 Minuten eingeschaltet, und alle
Eingangssignale sind entfernt.

2. Wählen Sie Instrument Calibration
(Instrumentkalibrierung) aus.

3. Wenn „Temp“ als „Status“ angezeigt wird,
klicken Sie auf „Calibrate“ (Kalibrieren),
um die Kalibrierung zu starten. Die
Kalibrierung kann 10 bis 15 Minuten in
Anspruch nehmen.

HINWEIS. Die Signalpfadkompensation stellt die einzige verfügbare Kalibrierung dar.

4. Wenn die Statusanzeige nach der
Kalibrierung nicht „Pass“ anzeigt,
kalibrieren Sie das Gerät neu, oder
lassen Sie das Gerät von qualifiziertem
Personal warten.
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Sync-Pickoff-Kompensation – Nur Optionen SD/HD
So kompensieren Sie das Sync-Pickoff ordnungsgemäß:

1. Schließen Sie das Synch-Pickoff-Kabel
an Kanal 1 an.

2. Schließen Sie den Sync-Pickoff-
BNC-Anschluss an einen BNC-zu-
Minigrabber-Anschluss an (Pomona
Electronics-Modellnummer 3789)

3. Schließen Sie die Minigrabber an den
PROBE COMP-Anschluss an.

4. Drücken Sie AUTOSET (AUTO-SETUP).
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5. Überprüfen Sie die Form des
angezeigten Signals, um zu bestimmen,
ob der Sync-Pickoff ordnungsgemäß
kompensiert ist.

6. Stellen Sie den Sync-Pickoff ggf. ein.
Wiederholen Sie diesen Vorgang so oft
wie erforderlich.
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Informationen zum Matrixtestsignal
Das Matrixtestsignal befindet sich auf den diesem Produkt beigefügten Signalursprungsdisketten. Es gibt ein
Matrixsignal für die Optionen SD und HD und ein Matrixsignal für die Option VGA. Das Matrixsignal enthält alle
Analogvideosignalanforderungen in verschiedenen Zeilennummern innerhalb eines Prüfmusterfeldes. Durch die Verwendung
eines einzigen Prüfmusters müssen die Prüfsignale während der verschiedenen Messungen nicht geändert werden. Sie
müssen nur die Anzahl der Zeilennummern angeben, für die die Messungen ausgeführt werden sollen. Verwenden Sie die
Setup-Datei (.vmset), die dem Format des von Ihnen verwendeten Matrixprüfsignals entspricht. Dadurch werden für jeden
Messtyp die als Standardeinstellung geeigneten Zeilennummern zur Verfügung gestellt. Eine vollständige Beschreibung der
Dateien auf den Signalursprungsdisketten finden Sie im Benutzerhandbuch für das automatische Videomesssystem VM5000.

Abbildung 1: Matrixsignal für Option SD/HD
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Matrixsignal für Elemente der Option SD/HD
Signalname Format Signalname Format Signalname Format
1. Farbbalken Alle 7. YPbPr-Ablenkzeit YPbPr 13. Gültige Rampe Alle
2. RGB-Impulsbalken RGB 8. YPbPr-

Ablenkfrequenz
YPbPr 14. YPbPr-

Flachrampe
YPbPr

3. RGB-
Frequenzablenkung

RGB 9. YPbPr-
Mehrfachburst

YPbPr 15. RGB-
Flachrampe

RGB

4. RGB-Zeitablenkung RGB 10. YPbPr-
Mehrfachburst

YPbPr 16. Flaches
Halbbild 7,5 %

Alle

5. RGB-
Mehrfachburst

YPbPr 11. RGB-
Übersprechen

RGB 17. Flaches
Halbbild 50 %

Alle

6. YPbPr-
Impulsbalken

YPbPr 12. YPbPr-
Übersprechen

YPbPr 18. Flaches
Halbbild 100 %

Alle

Abbildung 2: Matrixsignal für Option VGA

Matrixsignal der Elemente für Option VGA
Signalname Signalname
1. Hälfte weiß und Hälfte schwarz 5. Schwarz/weiß/schwarz
2. Neun Farbbalken 6. Vollweiß
3. 32 Stufen 7. Rampe
4. Alternierend weiß und schwarz 8. Hälfte weiß und Hälfte schwarz
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Starten der VM5000-Software
1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 HD and SD Video (Datei
> Anwendung ausführen > VM5000
HD und SD Video) oder File > Run
Application > VM5000 VGA Video
(Datei > Anwendung ausführen >
VM5000 VGA Video) aus.

Option SD/HD
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Das Gerät reduziert den Signalbereich
auf die obere Hälfte der Anzeige und
öffnet die VM5000-Anwendung in der
unteren Hälfte der Anzeige.

Option SD/HD

Option VGA
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Die Benutzeroberfläche der VM5000-Software
1. Menüleiste: Wählt die in der

Anwendungsanzeige anzuzeigenden
Bedienelemente für Einstellungen und
Informationen zu den Ergebnissen an.

2. Anwendungsanzeige: Zeigt die
Bedienelemente für die Konfiguration
und die Messergebnisse an.

3. Schaltfläche „Run“ (Ausführen): Initiiert
das Einrichten, startet die Messungen
und zeigt die Ergebnisse an.

4. Schaltfläche „Stop“ (Anhalten): Hält
Messungen an.

5. Schaltfläche „Picture“ (Bild): Zeigt das
Signal als Bild an.

6. Schaltfläche „Vectorscope“ (Vektorskop):
Zeigt das Signal im Vektorskop-Format
an. (Nur Option SD/HD)

7. Schaltfläche „Hide“ (Ausblenden):
Stellt die Hauptanzeige als
Gesamtbildschirm wieder her und
verbirgt das Anwendungsfenster hinter
der Hauptanzeige.
Wählen Sie Hide (Ausblenden) aus, um
(zum Anzeigen von Berichten) auf den
Windows-Desktop zuzugreifen. Wählen
Sie in der Hauptanzeige File > Minimize
(Datei > Minimieren >) aus, und klicken
Sie dann erneut auf die Schaltfläche
Hide (Ausblenden).

8. Schaltfläche „App“ (Anwendung):
Wählen Sie in der Hauptanzeige die
Schaltfläche App (Anwendung) aus, um
das VM5000-Anwendungsfenster nach
dem Ausblenden wiederherzustellen.

9. Schaltfläche „Exit“ (Beenden): Beendet
die VM5000-Anwendung und setzt das
Gerät zurück auf die standardmäßige
Hauptanzeige.
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Verfahren zum Ausführen von Messungen
1. Legen Sie die Formatparameter für das Eingangssignal mit Hilfe von Configuration > Format (Konfiguration >

Format) fest.

2. Wählen Sie eine oder mehrere durchzuführende Messungen mit Hilfe von Configuration > Measurements
(Konfiguration > Messungen) aus.

3. Legen Sie die Ausführungsoptionen für Messungen mit Hilfe von Configuration > Operation (Konfiguration > Betrieb)
fest.

4. Klicken Sie auf die Schaltfläche „Run“ (Ausführen), um die Messungen auszuführen und anzuzeigen.

5. Speichern Sie die Messergebnisse mit Hilfe von Utilities > Generate Report (Dienstprogramme > Bericht generieren)

Konfigurieren des Prüflings – Option VGA
Um die Messungen für den Prüfling durchzuführen, müssen Sie ein entsprechendes Videosignal an das VM5000-Gerät
anlegen. Dies erreichen Sie durch das Anzeigen einer Bitmapdatei auf dem PC, über den der Prüfling betrieben wird.
Beim Durchführen mehrerer Messungen stellt das Matrixsignal die bevorzugte Bitmapdatei dar. Wenn Sie nur eine
Messung ausführen, kann ein Prüfmuster mit volltändigem Halbbild anstelle des Matrixsignals verwendet werden. Alle
erforderlichen Bitmaps für Matrixsignal und Prüfmuster mit vollständigem Halbbild zum Überprüfen der Einhaltung des
VESA-Überprüfungsverfahrens – Auswertung der Anzeigegrafik-Untersysteme (Version 1, Rev. 1) finden Sie auf der
CD-ROM PC-Bitmapgrafik-Prüfsignaldateien.

1. Legen Sie die Auflösung und die
Aktualisierungsrate des Prüflings auf die
erforderlichen Werte fest.

2. Zeigen Sie auf dem PC mit dem
Prüfling den Inhalt der CD-ROM
PC-Bitmapgrafik-Prüfsignaldateien an.

3. Zeigen Sie entweder den Inhalt des
Ordners „Matrix“ oder des Ordners „Full
Field“ (Vollständiges Halbbild) an.

Öffnen Sie den Ordner „Matrix“, wenn
mehrere Messungen ausgeführt
werden sollen.

Wenn nur eine Messung ausgeführt
werden soll, öffnen Sie den
Ordner „Full Field“ (Vollständiges
Halbbild), und wählen Sie mit
Hilfe der folgenden Tabelle das
entsprechende Prüfmuster aus.
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Entsprechende Messungen für die jeweiligen Prüfmuster mit vollständigem Halbbild
Messung Jeweilige(s) Prüfmuster
Konflikt zwischen Kanälen 32-Stufen-Treppe
Versatz zwischen Kanälen Alternierend Weiß und Schwarz
Farbbalken Neun Farbbalken
H Sync Beliebiges Muster
H Sync-Jitter Beliebiges Muster
H Timing Schwarz/weiß/schwarz
Linearität Treppe
Luminanzstufen Alternierend Weiß und Schwarz
Rauschinjektions- verhältnis Vollweiß
Video-Transiente Alternierend Weiß und Schwarz
V Sync Beliebiges Muster
V Timing Hälfte weiß und Hälfte schwarz

Unabhängig davon, ob Sie ein einzelnes Prüfmuster auswählen oder mehrere Messungen auführen, müssen Sie die
Bitmapdatei auswählen, die zum Generieren des Videoprüfsignals angezeigt werden soll. Die ausgewählte Datei ist
abhängig vom zu prüfenden Format. Angenommen, Sie möchten ein Format mit einer Auflösung von 1280 x 1024 prüfen (die
Aktualisierungsrate wird bei der Auswahl von Bitmapdateien nicht berücksichtigt). Suchen Sie im entsprechenden Ordner
nach einen Dateinamen, der dem Format der durchzuführenden Prüfung entspricht. Wenn die Linearität geprüft werden soll,
müssen Sie entweder ein Treppenprüfmuster mit vollständigem Halbbild auswählen oder das Matrixprüfmuster verwenden.
Im Ordner „Staircase“ (Treppe) müssen Sie nach einer Datei mit dem Namen STEP1280X1024.bmp suchen. Suchen Sie im
Ordner „Matrix“ (Matrix) nach einer Datei mit dem Namen MAT1280X1024.bmp.

4. Wählen Sie die Bitmapdatei aus, die den
Anforderungen entspricht, und öffnen
Sie die Datei mit einem Programm wie
Paint Shop Pro.
Wenn Sie den Prüfling für eine zweite
Anzeige einrichten, können Sie den
Hintergrund der zweiten Anzeige auf die
Bitmapdatei festlegen, anstatt die Datei
in einem Bitmap-Editor zu öffnen.

24 Schnellstart-Benutzerhandbuch für VM5000



Umgang mit dem Gerät

5. Wählen Sie im Menü „View“ (Ansicht)
die Option View > Full Screen Preview
(Ansicht > Vollbildvorschau) aus.
Die BMP-Datei wird im Vollbildmodus
ohne Ränder angezeigt.

6. Trennen Sie den Ausgang des Prüflings
vom Monitor, und schließen Sie
den Ausgang des Prüflings an das
VM5000-Gerät an.

Festlegen des Eingangssignalformats – Optionen SD/HD
1. Wählen Sie Configuration > Format

(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht
„Format“ an.
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2. Wählen Sie das entsprechende
Videoformat für das gemessene Signal
aus.

3. Wählen Sie den entsprechenden
Farbraum für das gemessene Signal
aus.

Festlegen des Eingangssignalformats – Option VGA
1. Wählen Sie Configuration > Format

(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht
„Format“ (Format) an.
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2. Wählen Sie die entsprechende Auflösung
für das gemessene Signal aus.

3. Wählen Sie die Aktualisierungsrate für
das gemessene Signal aus. Je nach
der ausgewählten Auflösung sind einige
Aktualisierungsraten nicht auswählbar.

4. Wählen Sie den „Timing“-Standard für
das Signal aus.
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Erstellen eines benutzerdefinierten Formats
Wenn Sie ein Format prüfen möchten, das auf der Registerkarte „Format“ nicht aufgelistet ist, können Sie ein
benutzerdefiniertes Format erstellen.

1. Wählen Sie Configuration > Format
(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht
„Format“ (Format) an.

2. Aktivieren Sie das Kontrollkästchen
User-Defined Format
(Benutzerdefiniertes Format), um
ein benutzerdefiniertes Format zu
erstellen.
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3. Wählen Sie Add (Hinzufügen) aus, um
ein neues Format hinzuzufügen.

4. Geben Sie Werte sowohl für die
horizontalen als auch vertikalen
Parameter an, die das Format angeben.
Legen Sie die Sync-Polarität fest.
Geben Sie einen Wert für die
Aktualisierungsrate ein.

5. Geben Sie einen Formatnamen ein, und
wählen Sie Save (Speichern) aus, um
das neue Format zu speichern.

6. Wenn Sie ein neues Format gespeichert
haben, kann es aus dem Listenfeld
ausgewählt werden.
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Auswählen von Messungen
1. Wählen Sie Configuration> >

Measurements> (Konfiguration >
Messungen) aus.

2. Wählen Sie auf der Registerkarte
„Measurements“ (Messungen) die
gewünschten Messungen aus. Sie
können eine Messung oder eine
beliebige Kombination von Messungen
auswählen.

Option SD/HD

Option VGA
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Festlegen der Ausführungsoptionen für Messungen
1. Wählen Sie Configuration > Operation

(Konfiguration > Betrieb) aus.

Option SD/HD

Option VGA

Das Gerät zeigt die Ansicht „Operation“
(Betrieb) an. Mit Hilfe dieser
Einstellungen wird festgelegt, wie
das Gerät nach Klicken auf „Run“
(Ausführen) das Setup durchführt und
die Messwerte erfasst.

Option SD/HD

Option VGA
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2. Legen Sie das Setup des Geräts fest,
und bestimmen Sie die Ausführung von
Messungen.

Mit Setup & Run (Setup & Ausführen) werden die Geräteeinstellungen konfiguriert, und für jede ausgewählte
Messung und jede Messungserfassung wird eine Messung durchgeführt. Verwenden Sie diese Option, wenn
mehrere Messungen ausgeführt werden, die unterschiedliche Gerätesetups erfordern.

Mit Setup Only (Nur Setup) kann das Gerät für eine Messung konfiguriert werden, es wird jedoch keine Messungen
ausgeführt. Legen Sie mit Hilfe dieser Option benutzerdefinierte Einstellungen fest. Klicken Sie auf die Schaltfläche
„Run“ (Ausführen), um die vorgenommenen Einstellungen zu testen, nehmen Sie die erforderlichen Änderungen vor
(ändern Sie beispielsweise die Horizontalskala), und wählen Sie die Schaltfläche „Run“ (Ausführen) erneut aus.
Wenn Sie mit den festgelegten Einstellungen zufrieden sind, sammeln Sie mit Hilfe der Einstellung „Run Only“
(Nur ausführen) die Ergebnisse.

Mit Run Only (Nur ausführen) kann eine Messung mit der vorhandenen Gerätkonfiguration durchgeführt werden.
Verwenden Sie diese Einstellung, um Messungen mit benutzerdefinierten Einstellungen durchzuführen (siehe obige
Beschreibung zu „Setup Only“ (Nur Setup)).

3. Sie können auswählen, wie die
Anwendung Messungen erfasst („Run
Mode" (Betriebsmodus)).

Mit Once (Einmal) wird jede ausgewählte Messung so oft ausgeführt, wie von der Durchschnittseinstellung
angegeben, und anschließend wird die Ausführung von Messungen beendet. Hierbei handelt es sich um die
Standardeinstellung.

Mit Continuously (Fortlaufend) können fortlaufend Messungen durchgeführt werden. Sie müssen die Schaltfläche
„Stop“ (Anhalten) auswählen, um die Messungen anzuhalten.

Mit Once & Report (Einmal & Bericht) wird jede ausgewählte Messung so oft ausgeführt, wie von der
Durchschnittseinstellung angegeben, und anschließend wird die Ausführung von Messungen beendet und ein
Bericht generiert.

4. Aktivieren oder deaktivieren Sie „Auto
Scale“ (Automatisch skalieren). Mit
„Auto Scale“ (Automatisch skalieren)
können die vertikalen Skaleneinheiten
so angepasst werden, dass die
Eingangssignale das Raster so weit
wie möglich ausfüllen. „Auto Scale“
(Automatisch skalieren) wird einmal für
jede ausgewählte Messung angezeigt.
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5. Option SD/HD: Wählen Sie aus,
an welchem Kanal des Geräts das
Sync-Signal für die Triggerung anliegt.
Wenn Sie den falschen Triggerkanal
verwenden, wird eine Signalwarnung
ausgegeben (wenn „Signal Warnings“
(Signalwarnungen) aktiviert ist).
(Siehe Seite 8, Verbinden von
Eingangssignalen.)

Option SD/HD

6. Option VGA: Wählen Sie die
entsprechende Einstellung für „Line
Select“ (Zeilenauswahl) aus. Im
Modus „Single Line“ (Einzelne Zeile)
wird jede Messung für eine einzelne
Zeile (z. B. Zeile 153) ausgeführt. Im
Modus „Multiple Lines“ (Mehrere Zeilen)
werden Messungen über einen Bereich
von Zeilen (z. B. Zeilen 153 bis 185)
ausgeführt. Option VGA

Wenn Sie „Multiple Lines“ (Mehrere
Zeilen) auswählen, wird automatisch ein
Bericht in einer Datei gespeichert.

7. Option VGA: Wenn Sie die
RGBHV-Messschnittstelle verwenden,
müssen Sie das Kontrollkästchen Use
MIU (Messschnittstelle verwenden)
aktivieren.

Option VGA
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8. Option VGA: Wenn Sie die
Messschnittstelleneinheit verwenden,
können Sie die Einstellung „Sync
Polarity“ (Sync-Polarität) ignorieren.
Da die angegebenen Polaritäten für die
H Sync- und V Sync-Signale zwischen
den Timing-Standards variieren, werden
Sie vom VM5000-Gerät aufgefordert,
die H Sync- und V Sync-Signale
anzuschließen und auf diese Weise
automatisch ihre Polarität zu bestimmen.
Wenn die Polarität der Sync-Signale
festgelegt ist, beginnt der Messzyklus.
Dieser „Polaritätstest“ wird zu Beginn
jedes Messzykluses ausgeführt. Um
zu vermeiden, dass ein solcher Test
zu Beginn eines jeden Messzykluses
ausgeführt wird, führen Sie nur dann
Messungen aus, wenn „Auto Detect“
(Automatisch erfassen) ausgewählt ist.
Wenn ein Messzyklus bei aktivierter
Option „Auto Detect“ (Automatisch
erfassen) abgeschlossen wurde,
können Sie „Auto Detect“ (Automatisch
erfassen) deaktivieren, und Sie werden
nicht aufgefordert, die Signale für die
Polaritätsprüfung erneut zu ändern (die
Polarität der Sync-Signale wird vom
VM5000-Gerät gespeichert). Wenn Sie
die Formateinstellung für den Prüfling
ändern, sollten Sie jedes Mal einen
Messzyklus ausführen, wobei „Auto
Detect“ (Automatisch erfassen) aktiviert
sein muss.

9. Wählen Sie aus, welche Warnmeldungen
angezeigt werden sollen.
Weitere Informationen über
Warnungen finden Sie im
Benutzerhandbuch für das automatische
Videomesssystem VM5000.

Ausführen und Anzeigen von Messungen
Vor dem Ausführen einer Messung müssen Sie ein Signalformat auswählen, die gewünschten Messungen auswählen
und die Ausführungsoptionen konfigurieren.
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1. Klicken Sie auf die Schaltfläche
„Run“ (Ausführen). Die Ausführung
der Messungen wird begonnen, und
die Messergebnisse für die zuletzt
ausgewählten Messungen werden
angezeigt.

Option SD/HD

Option VGA

2. Wenn Sie die Ergebnisse einer anderen
Messung anzeigen möchten, wählen
Sie im Menü „Results“ (Ergebnisse)
die betreffende Messung aus. Wählen
Sie beispielsweise Results > Sync
(Ergebnisse > Sync) aus, um die
Sync-Messergebnisse anzuzeigen.

3. Wenn die Ausführung auf „Continuously“
(Fortlaufend) festgelegt ist, klicken Sie
auf die Schaltfläche Stop (Anhalten),
um die Ausführung der Messungen zu
beenden.

Schnellstart-Benutzerhandbuch für VM5000 35



Umgang mit dem Gerät

Verwenden des Oszilloskops
Wenn Sie Standardfunktionen des Oszilloskops VM5000 zum Ausführen von Messungen oder zum Anzeigen der
Eigenschaften eines Signals verwenden möchten, blenden Sie einfach die VM5000-Software aus. Sie müssen die
Ausführung der VM5000-Software nicht beenden.

1. Wählen Sie Hide (Ausblenden) aus, um
die VM5000-Software auszublenden.

2. Wenn die VM5000-Software
ausgeblendet ist, wird auf der Anzeige
die Schaltfläche App (Anwendung)
eingeblendet.

3. Wählen Sie App (Anwendung) aus,
um die VM5000-Software wieder
einzublenden.
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Fehlerbehebung bei Signalproblemen
Wenn beim Ausführen der Messungen Probleme auftreten, erhalten Sie möglicherweise Warn- oder Fehlermeldungen,
die Sie beim Ermitteln der Ursache des Problems unterstützen. In den folgenden Tabellen werden die Meldungen und die
möglichen Ursachen für Probleme beschrieben.

Warnmeldungen für die Option SD/HD

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

1 Acquisition Problem (Problem bei der
Erfassung)

Das Gerät kann kein Signal erzeugen,
oder die Signalpegel liegen außerhalb
des zulässigen Bereichs.

Alle Messungen

2 Bar Measurements Inconclusive
(Balkenmessungen ohne Ergebnis)

Das Gerät kann keine entsprechende
Synchronisation ermitteln, das
falsche Format ist ausgewählt, oder
das Signal ist verzerrt.

Messung kurzzeitiger
Verzerrungen

3 Channel Delay: Channel <x>
& <y>, Correlation Too Low
(Kanalverzögerung: Kanal <x> & <y>,
Korrelation zu gering)

Die Zeilennummer ist falsch
festgelegt, ein verzerrtes Signal oder
ein ungeeignetes Eingangssignal
mit einer zu kleinen Anzahl von
Übergängen.

Messung der
Kanalverzögerung

4 Channel Delay: Disjoint
Correlations Among Channels...
(Kanalverzögerung: disjunkte
Korrelationen zwischen Kanälen...)

Zwischen den Kanälen liegt ein
Gruppenverzögerungskonflikt vor,
oder es wird eine ungeeignete
Signalquelle verwendet.

Messung der
Kanalverzögerung

5 Color Bars: <Color> Bar Not Found
(Farbbalken: Balken <Farbe> nicht
gefunden)

Die Zeilennummer ist falsch
festgelegt, ein verzerrtes Signal,
ein falsches Format ist angegeben,
die angeschlossenen Kanäle liegen
in der falschen Reihenfolge vor,
eine falsche Farbmessung oder
übermäßiger Beschnitt des Signals.

Messung von
Farbbalken

6 Color Bars: Back Porch
Reference Questionable
(Farbbalken: zweifelhafte
Schwarzschalterreferenz)

Das Signal ist verzerrt. Messung von
Farbbalken

7 Frequency Response: Signal
Change: <freq1> ³ <freq2> MHz
(Frequenzgang: Signaländerung:
<Freq1> ³ <Freq2> MHz)

Signalpegel ist zu niedrig, falsches
Signal oder eine Änderung innerhalb
des Signals.

Messung des
Frequenzgangs

8 Frequency Response Individual
Channel Errors: Channel <x>
(Fehler bei einzelnem Kanal für
Frequenzgang: Kanal <x>)

Das Signal ist verzerrt, oder im Signal
fehlt ein Flag.

Messung des
Frequenzgangs

9 Frequency Response: Invalid results
for all channels (Frequenzgang:
Ungültige Ergebnisse für alle Kanäle)

Die Zeilennummer ist falsch
festgelegt, ein ungeeignetes
Eingangssignal oder eine falsche
Konfiguration.

Messung des
Frequenzgangs
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Warnmeldungen für die Option SD/HD (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

10 Multiburst: Signal Change: <freq1>
³ <freq2> MHz (Mehrfachburst:
Signaländerung: <Freq1> ³ <Freq2>
MHz)

Signalpegel ist zu niedrig, falsches
Signal oder eine Änderung innerhalb
des Signals.

Messung von
Mehrfachburst

11 Multiburst: Individual Channel
Errors: Channel <x>: Flag <= 0 mV
(Mehrfachburst: Fehler bei einzelnem
Kanal: Kanal <x>: Flag <= 0 mV)

Das Signal ist verzerrt, oder im Signal
fehlt ein Flag.

Messung von
Mehrfachburst

12 Multiburst: Individual Channel Errors:
Channel <x>: burst <n>: not detected
(Mehrfachburst: Fehler bei einzelnem
Kanal: Kanal <x>: Burst <n>: nicht
erkannt)

Signalpegel ist zu niedrig, verzerrte
Signale, ein Eingangssignal mit
weniger als sechs Frequenzpaketen
oder übermäßiger Beschnitt des
Signals.

Messung von
Mehrfachburst

13 Multiburst: Invalid results for all
channels (Mehrfachburst: Ungültige
Ergebnisse für alle Kanäle)

Die Zeilennummer ist falsch
festgelegt, ein ungeeignetes
Eingangssignal oder eine falsche
Konfiguration.

Messung von
Mehrfachburst

14 Noise: Signal Change: Chan <x>
(Rauschen: Signaländerung: Kanal
<x>)

Das Signal hat sich während der
Messung geändert.

Messung von Rauschen

15 Noise: Invalid results for all channels
(Rauschen: Ungültige Ergebnisse für
alle Kanäle)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung von Rauschen

16 Nonlinearity: Invalid Results: Channel
<x>: No ramp or step signal found
(Nichtlinearität: Ungültige Ergebnisse:
Kanal <x>: Kein Rampen- oder
Stufensignal gefunden)

Die Zeilennummer ist falsch
festgelegt, oder es liegt ein
ungeeignetes Eingangssignal an.

Messung von
Nichtlinearität

17 Nonlinearity: Signal Change: Channel
<x>: (Nichtlinearität: Signaländerung:
Kanal <x>:)

Das Signal hat sich während der
Messung geändert.

Messung von
Nichtlinearität

18 Short Time Distortion: Bar Start
Not Found (Kurzzeitige Verzerrung:
Balkenanfang nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, das Signal ist verzerrt,
oder es wurde ein falsches Format
ausgewählt.

Messung kurzzeitiger
Verzerrungen

19 Short Time Distortion: Bar End
Not Found (Kurzzeitige Verzerrung:
Balkenende nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, das Signal ist verzerrt,
oder es wurde ein falsches Format
ausgewählt.

Messung kurzzeitiger
Verzerrungen

20 Short Time Distortion: Invalid
results for Channel<x> (Kurzzeitige
Verzerrung: Ungültige Ergebnisse für
Kanal <x>)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung kurzzeitiger
Verzerrungen
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Warnmeldungen für die Option SD/HD (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

21 Sync Measurements Inconclusive
(Sync-Messungen ohne Ergebnis)

Das Gerät kann keine entsprechende
Synchronisation ermitteln, das
falsche Format ist ausgewählt, oder
das Signal ist verzerrt.

Messung der
Synchronisation

22 Sync Measurement: <n> Not Found
(Sync-Messung: <n> nicht gefunden)

Das Gerät kann keine entsprechende
Synchronisation finden.

Messung der
Synchronisation

23 2T pulse not found in luminance
component of signal (2T-Puls in
Luminanzkomponente des Signals
nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung kurzzeitiger
Verzerrungen

24 Writing over file <filename> (Datei
<Dateiname> wird überschrieben)

Das Gerät überschreibt eine
vorhandene Datei.

Abrufen von
Einstellungen;
Generieren eines
Berichts

25 Sync Acquisition Problem:
(Problem bei der Erfassung der
Synchronisation:) Entweder das
Gerät kann kein Signal erzeugen,
oder die Signalpegel liegen außerhalb
des gültigen Bereichs.

Triggerung

Warnmeldungen für die Option VGA

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

1 Sync edge locations questionable.
Make sure that the selected
format is correct. (Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von H Sync,
V Sync und V Timing

2 H Timing: Incorrect signal in Channel
<1–3>. Use Black-White-Black
signal. Sync edge locations
questionable. Make sure that the
selected format is correct. (H Timing:
Falsches Signal in Kanal <1–3>.
Verwenden Sie das Schwarz-Weiß-
Schwarz-Signal. Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von H Timing
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Warnmeldungen für die Option VGA (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

3 H Timing: Incorrect signal in Channel
<1–3>. Use Black-White-Black
signal. (H Timing: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Schwarz-Weiß-Schwarz-Signal.)

Das Schwarz-Weiß-Schwarz-Signal
wird nicht verwendet.

Messung von H Timing

4 Invalid Results: Acquisition Problem:
Either cannot trigger or the signal
levels are out of range or acquired
less than the requested samples.
(Ungültige Ergebnisse: Problem
bei der Erfassung: Entweder kann
kein Signal erzeugt werden, oder
die Signalpegel liegen außerhalb
des zulässigen Bereichs, oder es
wurden weniger als die angeforderten
Abtastwerte erfasst.)

Erfassung fehlgeschlagen: Trigger
fehlt, falsches Format oder andere
Ursache für die fehlgeschlagene
Erfassung des Signals.

Alle Messungen

5 Linearity: Signal Change: Channel
<x>: (Linearität: Signaländerung:
Kanal <x>:)

Stabilitätsproblem während der
kontinuierlichen Ausführung: Die
Rampe ist nicht mehr vorhanden,
oder die Anzahl der Stufen hat sich
geändert.

Messung der Linearität

6 Linearity: Signal Fidelity Problem:
Channel <x> Resolution mismatch:
Line A<x> bits, Line B <y> bits:
Steps not found (Problem mit der
Signalwiedergabe: Kanal <x>
Auflösungskonflikt: Zeile A <x>
Bits, Zeile B <y> Bits: Stufen nicht
gefunden)

Bei zweizeiligen Rampen (unterer
Bereich der Rampe in einer Zeile und
oberer Bereich der Rampe in der
zweiten Zeile) stimmt die Bitauflösung
der LSB-Treppenrampen nicht
überein, oder die Gesamtzahl der
Stufen entspricht nicht (2^n — 1).

Messung der Linearität

7 Linearity: Error occurred in switch
accessory (Linearität: Fehler in
Austauschzubehör)

Die RGBHV-Messschnittstellenein-
heit reagiert nicht ordnungsgemäß.

Messung der Linearität

8 Sync edge locations questionable.
Make sure that the selected
format is correct. (Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von
Farbbalken,
Videokanalkonflikt,
Kanal-zu-Kanal-
Zeitversatz,
Luminanzstufen,
Videokanalkonflikt,
V Sync, V Timing und
Video-Transiente.
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Warnmeldungen für die Option VGA (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

9 Color Bars: Yellow/Cyan/Green/Ma-
genta/Red/Blue/Black Bar
not found. (Farbbalken:
Balken Gelb/Zyan/Grün/Ma-
genta/Rot/Blau/Schwarz nicht
gefunden.)

Das Farbbalkensignal wird nicht
verwendet.

Messung von
Farbbalken

10 Ch-Ch Skew: Incorrect signal in
Channel <1–3>. Use the Alternate
White and Black bar signal. (Versatz
zwischen Kanälen: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Signal mit alternierenden weißen und
schwarzen Balken.)

Das Format ist falsch festgelegt. Messung des Versatzes
zwischen Kanälen

11 Ch-Ch Skew: Incorrect signal in
Channel <1–3>. Use the Alternate
White and Black bar signal.
(Luminanzstufen: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Signal mit alternierenden weißen und
schwarzen Balken.)

Alternierendes Weiß-Schwarz-Signal
wird nicht verwendet.

Messen von
Luminanzstufen

12 Video Transient: Incorrect signal
in Channel <1–3>. Use the
Alternate White & Black bar signal.
(Video-Transiente: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Signal mit alternierenden weißen und
schwarzen Balken.)

Alternierendes Weiß-Schwarz-Signal
wird nicht verwendet.

Messen von
Video-Transienten

13 H Sync Jitter: Sync edge locations
questionable. Make sure that
the selected format is correct.
(H Sync Jitter: Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von
H Sync-Jitter

14 Noise: Invalid results for some
channels. (Rauschen: Ungültige
Ergebnisse für einige Kanäle.)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung von Rauschen

15 Ch-Ch Mismatch: Incorrect signal in
Channel <1–3>. Use the 32–step
Staircase signal in true color mode.
(Konflikt zwischen Kanälen: Falsches
Signal in Kanal <1–3>. Verwenden
Sie das 32-stufige Treppensignal im
True Color-Modus.

Treppensignal mit 32 Stufen wird
nicht verwendet

Messung von Konflikten
zwischen Kanälen
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Fehlermeldungen

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

1 File Name Error: File doesn’t exist:
<filename> (Dateinamenfehler: Datei
ist nicht vorhanden: <Dateiname>)

Die ausgewählte VMSET-Datei
ist nicht vorhanden. (Sie müssen
den vollständigen Pfad angeben,
wenn sich die Datei nicht im Ordner
C:\VM5000TV befindet.)

Abrufen von
Einstellungen

2 Cannot write file: file already
exists: <filename> (Datei kann nicht
geschrieben werden: Datei ist bereits
vorhanden: <Dateiname>)

Der <Dateiname> muss geändert
werden, damit die Datei gespeichert
werden kann.

Speichern von
Einstellungen;
Generieren von
Berichten

3 File Name Error. Invalid character(s)
in file name (Dateinamenfehler.
Ungültige Zeichen in Dateiname)

Ungültige Zeichen im Dateinamen.
Die folgenden Zeichen sind ungültig:
“|”, “:”, “/”, “,”, “<“, „>“, „*“, „\“ und „?“.

Speichern von
Einstellungen;
Generieren von
Berichten

4 No Measurement Selected (Es wurde
keine Messung ausgewählt)

Im Menü „Configuration >
Measurements“ (Konfiguration
> Messungen) wurden keine
Messungen ausgewählt.

Ausführen von
Messungen; Generieren
eines Berichts

5 Cannot create Report. Not all selected
measures have been Run (Bericht
kann nicht erstellt werden. Nicht alle
ausgewählten Messungen wurden
ausgeführt.)

Sie müssen eine Messung ausführen
und warten, bis diese abgeschlossen
ist, bevor ein Bericht generiert werden
kann.

Generieren von
Berichten.

6 Invalid Filename (Ungültiger
Dateiname)

Die Datei ist nicht vorhanden, oder
der Pfad ist falsch. Sie müssen
den vollständigen Pfad angeben,
wenn sich die Datei nicht im Ordner
C:\VM5000TV befindet.

Aufrufen von Einstel-
lungen,Speichern von
Einstellungen, Gener-
ieren von Berichten
(nur wenn über GPIB
aufgerufen)

7 Invalid Argument (Ungültiges
Argument)

Für den betreffenden GPIB-Befehl
wurde ein falsches Argument
verwendet.

Alle GPIB-Befehle

8 Command Overflow (Befehlsüberlauf) Die GPIB-Befehle wurden zu
schnell gesendet. Verlängern Sie
die Verzögerung zwischen zwei
Befehlen, um dieses Problem
zu vermeiden (Intervalle von
100 Millisekunden empfohlen), oder
verwenden Sie Handshaking mit
OPComplete.

Beim zu schnellen
Senden von
GPIB-Befehlen.
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Fehlermeldungen (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

9 Command Missed (Befehl fehlt) Dieser Fehler gibt an, dass ein in der
letzten Sekunde gesendeter Befehl
eventuell nicht verarbeitet wurde.
Deshalb sollten Sie zurück zu einer
aktuellen (bekannten) Konfiguration
wechseln und die letzten Befehle
erneut senden.

Senden von
GPIB-Befehlen

10 Error occurred in configuring MIU
(Fehler bei der Konfiguration der
Messschnittstelleneinheit)

Falsche serielle Verbindung zur
Messschnittstelleneinheit, oder
eines der CH1/-CH2-/CH3-/CH4-
Anschlusskabel ist nicht am
VM5000-Gerät angeschlossen.

Ausführen von Mes-
sungen mit Hilfe der
Messschnittstellenein-
heit.
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Anwendungen

Einfache Farbbalkenmessung – Optionen SD/HD
Amplitudenmessungen werden normalerweise mit dem Farbbalkenprüfsignal ausgeführt, das die RGB-Komponenten
ein- und ausschaltet, sodass alle acht möglichen Farbkombinationen (Weiß, Gelb, Zyan, Grün, Magenta, Rot, Blau und
Schwarz) entstehen können. Es gibt verschiedene Formen des Farbbalkenprüfsignals, von denen jedes einen maximalen
dynamischen Bereich von 700 mV = 100 % oder 75 % bei einer RGB-Amplitude von 525 mV verwendet. In den folgenden
Tabellen sind die Amplitudenbereiche für die Komponente Y′P′bP′r für die verschiedenen Standards von 100 %- und
75 %-Farbbalken angegeben.

Amplitudenbereiche für verschiedene 100 %-Farbbalkensignalformate
480p/576p 1080/720

Farb-
balken

R
(mV)

G
(mV)

B
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Weiß 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0
Gelb 700 700 0 620.2 -349.8 56.9 649.5 -350.0 32.1
Zyan 0 700 700 490.7 118.0 -349.9 551.2 80.2 -350.0
Grün 0 700 0 410.9 -231.7 -293.0 500.6 -269.8 -317.9
Magenta 700 0 700 289.1 231.7 293.0 199.4 269.8 317.9
Rot 700 0 0 209.3 -118.0 349.9 148.8 -80.2 350.0
Blau 0 0 700 79.8 349.8 -56.9 50.5 350.0 -32.1
Schwarz 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

Amplitudenbereiche für verschiedene 75 %-Farbbalkensignalformate
480p/576p 1080/720

Farb-
balken

R
(mV)

G
(mV)

B
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Weiß 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0
Gelb 525 525 0 465.2 -262.3 42.7 487.1 -262.5 24.1
Zyan 0 525 525 368.0 88.5 -262.4 413.4 60.2 -262.5
Grün 0 525 0 308.2 -173.8 -219.7 375.5 -202.3 -238.4
Magenta 525 0 525 216.8 173.8 219.7 149.5 202.3 238.4
Rot 525 0 0 157.0 -88.5 262.4 111.6 -60.2 262.5
Blau 0 0 525 59.9 262.3 -42.7 37.9 262.5 -24.1
Schwarz 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0
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Je nach dem zu testenden Gerät ist eine Abweichung der tatsächlichen Werte zulässig. Beispielsweise können von den
progressiven Ausgängen von DVD-Playern Einstellungen für die zugehörigen Ausgänge eingeführt werden, die die
Gesamtmessergebnisse beeinflussen können. Abweichungen der Ebene der Komponenten können unterschiedliche
Farbtöne und Sättigungen des angezeigten Bildes bewirken. Das Farbbalkenprüfsignal ermöglicht es Ihnen,
Verstärkungsabweichungen zwischen den Kanälen zu bestimmen und sicherzustellen, dass das Signal nicht verzerrt ist.
Dies könnte eine starke Signalamplitudenbegrenzung zur Folge haben.

Das Tektronix-Matrixmuster verwendet ein 100 %-Farbbalkensignal, um den vollen dynamischen Bereich jeder Komponente
zu testen. Das Farbbalkenmuster befindet sich nahe dem oder im oberen Bereich des Matrixmusters; die Zeilennummern,
an denen es auftritt, sind für jeden Standard unterschiedlich. Die angegebenen Zeilennummern sind die Standardwerte
zum Generieren der Testmatrix, aber bei einigen zu prüfenden Systemen verschieben sich möglicherweise die Zeilen
im Bild an eine andere Position.

Format 1080i 720p 480p 576p
Zeile 21 - 84 26 - 153 43 - 106 45 - 108
Quelle 584 - 647

Das VM5000 führt die Farbbalkenmessungen aus, indem zunächst die relative Amplitude für jeden der drei Kanäle ermittelt
wird. Acht Amplitudenmessungen werden auf jedem Kanal vorgenommen, das sind insgesamt 24 Messungen in weniger als
einer halben Sekunde. Anhand der folgenden Schritte werden die typischen Messergebnisse für ein 1080i-Signal gezeigt.
Die Amplitude für jede Balkenhöhe wird in Bezug auf den Schwarzschalter gemessen. Amplituden werden mit Werten
von gemittelten Signalen in jedem ermittelten Balken berechnet. Deshalb ist es wichtig sicherzustellen, dass das Video
vollständig im Erfassungsfenster des Geräts angezeigt wird, wenn am Gerät manuelle Einstellungen vorgenommen wurden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application >
VM5000 HD and SD Video (Datei >
Anwendung ausführen > VM5000 HD
und SD Video) aus.
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3. Wählen Sie in der Anwendung VM5000
File > Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)

5. Stellen Sie das Eingangssignalformat
ein. (Siehe Seite 25, Festlegen des
Eingangssignalformats – Optionen
SD/HD.)

6. Wählen Sie Configuration >
Measurements (Konfiguration >
Messungen) aus.
Beachten Sie, dass in der
Standardeinstellung „Color Bars“
(Farbbalken) ausgewählt ist.

7. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt.
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Einfache Farbbalkenmessung – Option VGA
Amplitudenmessungen werden normalerweise mit dem Farbbalkenprüfsignal ausgeführt, das die RGB-Komponenten
ein- und ausschaltet, sodass alle acht möglichen Farbkombinationen (Weiß, Gelb, Zyan, Grün, Magenta, Rot, Blau und
Schwarz) entstehen können. Es gibt verschiedene Formen des Farbbalkenprüfsignals, von denen jedes einen maximalen
dynamischen Bereich von 700 mV = 100 % oder 75 % bei einer RGB-Amplitude von 525 mV verwendet. In der folgenden
Tabelle wird die Amplitude für das RGB-Signal bei 100 % und 75 % dargestellt.

Amplitude für 100 %-Farbbalkensignal
Farbbalken R (mV) G (mV) B (mV)
Weiß 700 700 700
Gelb 700 700 0
Zyan 0 700 700
Grün 0 700 0
Magenta 700 0 700
Rot 700 0 0
Blau 0 0 700
Schwarz 0 0 0

Amplitude für 75 %-Farbbalkensignalformate
Farbbalken R (mV) G (mV) B (mV)
Weiß 700 700 700
Gelb 525 525 0
Zyan 0 525 525
Grün 0 525 0
Magenta 525 0 525
Rot 525 0 0
Blau 0 0 525
Schwarz 0 0 0

Das Tektronix-Matrixmuster verwendet ein 100 %-Farbbalkensignal, um den vollen dynamischen Bereich der einzelnen
Komponenten zu testen. Das Farbbalkenmuster befindet sich nahe dem oder im oberen Bereich des Matrixmusters;
die Zeilennummern, an denen es auftritt, sind für jedes Format unterschiedlich. In den folgenden Tabellen sind die
Zeilennummern aufgeführt, in denen sich die unterschiedlichen Muster im Matrixsignal bei einer Aktualisierungsrate von 60 Hz
befinden. Bei anderen Aktualisierungsraten kann die tatsächliche Ausgangszeilennummer deutlich von der Rate von 60 Hz
abweichen. Um die Position der aktiven Videozeilennummer für ein bestimmtes Muster bei einer anderen Aktualisierungsrate
anzeigen zu lassen, suchen Sie die Microsoft Excel-Datei „Matrix.xls“, die sich auf der Software-CD für VM5000 befindet. In
dieser Datei sind die tatsächlichen aktiven Videozeilennummern für alle unterstützten Aktualisierungsraten aufgelistet.
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Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (640 x 480
bis 1280 x 1024)
Muster 640 x 480 800 x 600 1024 x 768 1280 x 1024
Hälfte weiß und Hälfte schwarz 36 – 83 28 – 87 36 – 112 42 – 143
Neun Farbbalken 84 – 179 88 – 207 113 – 265 144 – 348
32 Stufen 180 – 227 208 – 267 266 – 342 349 – 450
Alternierend Weiß und Schwarz 228 – 275 268 - 327 343 - 419 451 -552
Schwarz/weiß/schwarz 276 – 323 328 – 387 420 – 496 553 – 654
Vollweiß 324 – 371 388 – 447 497 – 572 655 – 756
Rampe 372 – 467 448 – 567 573 – 726 757 – 962
Hälfte weiß und Hälfte schwarz 468 – 515 568 – 627 727 – 803 963 – 1065

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (1600 x 1024
bis 1900 x 1200)
Muster 1600 x 1024 1600 x 1200 1920 x 1080 1920 x 1200
Hälfte weiß und Hälfte schwarz 36 – 132 50 – 169 38 – 140 43 – 162
Neun Farbbalken 143 – 337 170 – 409 150 – 356 163 – 402
Treppe 347 – 439 410 – 529 366 – 464 403 – 522
Alternierend Weiß und Schwarz 450 – 542 530 – 649 474 – 572 523 – 642
Schwarz/weiß/schwarz 552 – 644 650 – 769 582 – 680 643 – 762
Vollweiß 655 – 747 770 – 889 690 – 788 763 – 882
Rampe 757 – 951 890 – 1129 798 – 1004 883 – 1122
Hälfte weiß und Hälfte schwarz 962 – 1059 1130 – 1249 1014 – 1117 1123 – 1242

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (1920 x 1440
bis 2048 x 2048)
Muster 1920 x 1440 2048 x 1536 2048 x 2048
Hälfte weiß und Hälfte schwarz 50 – 193 53 – 198 71 – 265
Neun Farbbalken 194 – 481 213 – 505 285 – 674
Treppe 482 – 625 520 – 659 695 – 879
Alternierend Weiß und Schwarz 626 – 769 674 – 812 899 – 1084
Schwarz/weiß/schwarz 770 – 913 828 – 966 1104 – 1289
Vollweiß 914 – 1057 981 – 1120 1309 – 1493
Rampe 1058 – 1345 1135 – 1427 1514 – 1903
Hälfte weiß und Hälfte schwarz 1346 – 1489 1442 – 1588 1923 – 2118
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Das VM5000 führt die Farbbalkenmessungen aus, indem zunächst die relative Amplitude für jeden der drei Kanäle ermittelt
wird. Acht Amplitudenmessungen werden auf jedem Kanal vorgenommen, das sind insgesamt 24 Messungen in weniger als
einer halben Sekunde. Anhand der folgenden Schritte werden die typischen Messergebnisse für ein 1024 x 768-Signal
gezeigt. Die Amplitude für jede Balkenhöhe wird in Bezug auf den Schwarzschalter gemessen. Amplituden werden mit
Werten von gemittelten Signalen in jedem ermittelten Balken berechnet. Deshalb ist es wichtig sicherzustellen, dass das
Video vollständig im Erfassungsfenster des Geräts angezeigt wird, wenn am Gerät manuelle Einstellungen vorgenommen
wurden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 VGA Video (Datei >
Anwendung ausführen > VM5000 VGA
Video) aus.

3. Wählen Sie in der Anwendung VM5000
File > Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)

5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 26, Festlegen des
Eingangssignalformats – Option VGA.)
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6. Wählen Sie Configuration >
Measurements (Konfiguration >
Messungen) aus.
Beachten Sie, dass in der
Standardeinstellung „Color Bars“
(Farbbalken) ausgewählt ist.

7. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt.
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Anzeige relativ zu Referenzfarbbalkenmessungen
Das VM5000 zeigt die Messergebnisse in zwei Formen an: wie gemessen und in Bezug auf einen Referenzwert. Der relative
Wert wird durch Subtraktion des gemessenen Werts von einem Referenzwert berechnet. Um Messergebnisse in Bezug
auf einen Referenzwert anzeigen zu lassen, müssen Sie Enable Relative Results (Relative Ergebnisse aktivieren) auf
der Registerkarte Reference & Limits (Referenz & Grenzen) des Konfigurationsbildschirms auswählen. Referenzwerte
werden in speziellen Textdateien mit durch Komma unterteilten Werten (CSV) angegeben. Das VM5000-Gerät enthält
einige Toleranzmaskendateien, die Sie bearbeiten können, sodass Sie die Referenzwerte Ihrer Anwendung entsprechend
angeben können.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 HD and SD Video
oder VM5000 VGA Video (Datei >
Anwendung ausführen > VM5000 HD
und SD Video bzw. VM5000 VGA Video)
aus.

3. Wählen Sie in der Anwendung VM5000
File > Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)
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5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 25, Festlegen des
Eingangssignalformats – Optionen
SD/HD.) (Siehe Seite 26, Festlegen des
Eingangssignalformats – Option VGA.)

6. Wählen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

7. Aktivieren Sie das Kontrollkästchen
Enable Relative Result Display
(Anzeige von relativen Ergebnissen
aktivieren).
In der Standardeinstellung wählt
die Anwendung VM5000 aus
den verfügbaren Toleranzmasken
automatisch eine zum ausgewählten
Signalformat passende Referenzdatei
aus.

8. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).
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Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt. Beachten Sie, dass nun
die Registerkarten „Relative“ (Relativ)
und „Reference“ (Referenz) ausgewählt
werden können.

Option SD/HD

Option VGA
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9. Wählen Sie die Registerkarte Reference
(Referenz) aus, um die Referenzwerte
zum Berechnen der relativen Werte
anzeigen zu lassen.

Option SD/HD

Option VGA

10. Wählen Sie die Registerkarte Relative
(Relativ) aus, um die berechneten
relativen Werte anzeigen zu lassen.
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11. Wählen Sie die Optionsschaltfläche
% aus, um die prozentuale Differenz
zwischen dem gemessenen Wert und
dem Referenzwert anzeigen zu lassen.

Option SD/HD

Option VGA
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Anzeigen von Farbbalkenmessungen mit Grenzwertprüfung
Das VM5000-Gerät kann Messergebnisse im Vergleich zu einem Grenzwert und mit einer Pass/Fehler-Angabe anzeigen.
Wie bei den relativen Messungen wird der Grenzwert in einer Textdatei mit durch Komma getrennten Werten (CSV-Format)
angegeben. Das VM5000-Gerät enthält einige Toleranzmaskendateien, die Sie bearbeiten können, sodass Sie die
Grenzwerte Ihrer Anwendung entsprechend angeben können. Grenzwerte bestehen aus einem Maximalwert und einem
Minimalwert. Messwerte, die zwischen dem maximalen und dem minimalen Grenzwert liegen, haben die Grenzwertprüfung
bestanden. Messwerte, die oberhalb des maximalen oder unterhalb des minimalen Grenzwerts liegen, haben die
Grenzwertprüfung nicht bestanden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 HD and SD Video
oder VM5000 VGA Video (Datei >
Anwendung ausführen > VM5000 HD
und SD Video bzw. VM5000 VGA Video)
aus.
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3. Wählen Sie File > Recall Default
Setup (Datei > Grundeinstellungen
abrufen) aus, um alle Einstellungen
auf die werkseitigen Standardwerte
zurückzusetzen.

Option SD/HD

Option VGA

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)

5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 7, Voraussetzungen
für Eingangsverbindungen
– Optionen SD/HD.) (Siehe
Seite 7, Voraussetzungen für
Eingangsverbindungen – Option
VGA.)
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6. Wählen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

Option SD/HD

Option VGA

7. Wählen Sie Enable Limit Testing
(Grenzwertprüfung aktivieren) aus.
In der Standardeinstellung wählt
die Anwendung VM5000 aus
den verfügbaren Toleranzmasken
automatisch eine zum ausgewählten
Signalformat passende Grenzwertdatei
aus.

Option SD/HD

Option VGA

8. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).
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Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt. Beachten Sie, dass nun
die Registerkarte „Limits“ (Grenzwerte)
ausgewählt werden kann.
Wenn die Grenzwertprüfung aktiviert ist,
werden die Ergebnisse in grün oder rot
formatiertem Text angezeigt. Grüner Text
bedeutet, dass die Prüfung bestanden
wurde (der Messwert hat die Grenzwerte
nicht überschritten). Roter Text bedeutet,
dass die Prüfung nicht bestanden wurde
(der Messwert hat den maximalen
Grenzwert überschritten bzw. den
minimalen Grenzwert unterschritten).

Option SD/HD

Option VGA

Schnellstart-Benutzerhandbuch für VM5000 59



Anwendungen

9. Wählen Sie die Registerkarte Limits
(Grenzwerte) aus, um die verwendeten
Grenzwerte anzeigen zu lassen.
Wählen Sie entweder min oder max
aus, um die für die minimal und maximal
zulässigen Werte angegebenen Grenzen
anzeigen zu lassen.

Option SD/HD

Option VGA
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Grenzwertprüfung mit zwei Messungen
Mit dem VM5000-Gerät können Grenzwertprüfungen mit mehreren Messungen gleichzeitig ausgeführt werden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 HD and SD Video
oder VM5000 VGA Video (Datei >
Anwendung ausführen > VM5000 HD
und SD Video bzw. VM5000 VGA Video)
aus.

Option SD/HD

3. Wählen Sie File > Recall Default
Setup (Datei > Grundeinstellungen
abrufen) aus, um alle Einstellungen
auf die werkseitigen Standardwerte
zurückzusetzen.

Option SD/HD

Option VGA
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4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)

5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 25, Festlegen des
Eingangssignalformats – Optionen
SD/HD.) (Siehe Seite 26, Festlegen des
Eingangssignalformats – Option VGA.)

6. Wählen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

Option SD/HD

Option VGA

7. Wählen Sie Enable Limit Testing
(Grenzwertprüfung aktivieren) aus.
In der Standardeinstellung wählt
die Anwendung VM5000 aus
den verfügbaren Toleranzmasken
automatisch eine zum ausgewählten
Signalformat passende Grenzwertdatei
aus.

Option SD/HD
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Option VGA

8. Klicken Sie auf die Registerkarte
Measurements (Messungen), um die
auszuführende Messung auszuwählen.

9. Wählen Sie zwei Messungen aus:

Option SD/HD: Aktivieren Sie
Color Bars (Farbbalken) und Sync
(Synchronisation).

Option SD/HD

Option VGA: Aktivieren Sie Color
Bars (Farbbalken) und Luma Levels
(Luminanzstufen).

Option VGA

10. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).
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Wenn die Messungen beginnen, wird der
Bildschirm für den Messstatus angezeigt.
Wenn die Messungen abgeschlossen
sind, wird für die ausgewählten
Messungen „Pass“ (Bestanden) oder
„Fail“ (Fehler) angezeigt.

Option SD/HD

Option VGA
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11. Um die Ergebnisse für die einzelnen
ausgewählten Messungen anzuzeigen,
klicken Sie auf das Menü Results
(Ergebnisse), und wählen Sie eine der
Messungen aus.
Der Ergebnisbildschirm für die
ausgewählte Messung wird angezeigt.

Option SD/HD

Option VGA
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12. Um die Ergebnisse für die andere
ausgewählte Messung anzuzeigen,
klicken Sie auf das Menü Results
(Ergebnisse), und wählen Sie die andere
Messung aus.

Option SD/HD

Option VGA

Ausführen von Messungen über mehrere Zeilen – Nur Option VGA
Bei Messungen mit dem VM5000 wird mit der Zeilennummer angegeben, an welcher Stelle die Messung vorgenommen wird
(bzw. wann die Messung vorgenommen wird). (Wenn Sie die Luminanzstufe messen möchten, müssen Sie sicherstellen,
dass die Messung innerhalb des aktiven Videobereichs des Signals vorgenommen wird.) Gelegentlich müssen Sie eine
Messung über mehrere Zeilen ausführen. (Beispielsweise müssen Sie möglicherweise überprüfen, ob die Luminanzstufe
(„Luma Level“) vom oberen Ende bis zum unteren Ende des Bildschirms konsistent ist.) Verwenden Sie dazu die Einstellung
Multiple Lines (Mehrere Zeilen) unter Line Select (Zeilenauswahl) auf dem Register Operations (Vorgänge).

HINWEIS. Einige Messungen sind im Modus „Multiple Lines“ (Mehrere Zeilen) nicht verfügbar.
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Da Sie angeben können, dass Messungen für jede Zeile vorgenommen werden, erhalten Sie möglicherweise eine Vielzahl
von Messergebnissen. Deshalb werden die Ergebnisse aller im Modus „Multiple Line“ (Mehrere Zeilen) ausgeführten
Messungen nicht auf dem Bildschirm angezeigt, sondern in einer Datei gespeichert. Die Ergebnisdatei kann im Format
RTF, CSV oder PDF gespeichert werden. Um die Ergebnisse einer Messung im Modus „Multiple Lines“ (Mehrere Zeilen)
abzurufen, müssen Sie anstelle der Anwendung für das VM5000-Gerät Microsoft Word, Excel oder Adobe Reader
verwenden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 VGA Video (Datei >
Anwendung ausführen > VM5000 VGA
Video) aus.

3. Wählen Sie in der Anwendung VM5000
File > Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)
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5. Wählen Sie Configuration > Format
(Konfiguration > Format) aus.

6. Wählen Sie die gewünschten
Einstellungen für Resolution
(Auflösung), Refresh Rate
(Aktualisierungsrate) und Timing
aus.

7. Wählen Sie Configuration > Operations
(Konfiguration > Vorgänge) aus.

8. Klicken Sie im Bereich „Line Select“
(Zeilenauswahl) auf Multi Lines
(Mehrere Zeilen).
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9. Beachten Sie, dass das Register „Multi
Lines“ (Mehrere Zeilen) nun ausgewählt
werden kann und dass „Measurements“
(Messungen) nicht mehr aktiviert ist.
Klicken Sie auf das Register „Multi Lines“
(Mehrere Zeilen).

Auf der Registerkarte „Multi Lines“
(Mehrere Zeilen) können Sie angeben,
welche Messungen ausgeführt werden
und über welchen Zeilenbereich sie
vorgenommen werden.

Für jede Messung sind zwei
Eingabefelder vorhanden: „Start
Line“ (Anfangszeile) und „End Line“
(Endzeile). Verwenden Sie diese
zwei Felder, um den Zeilenbereich
anzugeben, über den die Messung
erfolgen soll.

10. Um eine auszuführende Messung
auszuwählen, aktivieren Sie das
Kontrollkästchen neben der Messung.
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11. Geben Sie die Zeilennummern in die
Felder Start Line (Anfangszeile) und
End Line (Endzeile) ein.

Nachdem Sie die gewünschten
Messungen ausgewählt haben, müssen
Sie den Namen der Datei angeben, in
der die Messergebnisse gespeichert
werden.

12. So geben Sie die Parameter der Datei
an, in der die Ergebnisse gespeichert
werden:

Klicken Sie auf Utilities
(Dienstprogramme) > Generate
Report (Bericht generieren).

Daraufhin wird das Fenster zum
Generieren eines Berichts angezeigt.

13. Klicken Sie auf Browse (Durchsuchen),
um den Dateinamen und den Speicherort
zu ändern. Daraufhin wird das Dialogfeld
Save (Speichern) angezeigt.

70 Schnellstart-Benutzerhandbuch für VM5000



Anwendungen

14. Geben Sie den Dateinamen ein,
oder navigieren Sie in das gewünschte
Verzeichnis, in dem die Datei gespeichert
werden soll.

15. Wählen Sie das Format des Berichts aus
den unter Files of type (Dateien vom
Typ) aufgelisteten Formaten aus.

16. Klicken Sie auf Save (Speichern).

17. Wenn Sie eine Bildschirmaufnahme
des Signals im Bericht speichern
möchten, wählen Sie Configuration
(Konfiguration) >Operations (Vorgänge)
aus, um das Fenster für Vorgänge
anzuzeigen. Aktivieren Sie Embed
Screen Shot (Bildschirmaufnahme
einbetten) unter Report Mode
(Berichtsmodus). Diese Option ist
nur verfügbar, wenn Files of type
(Dateien vom Typ) auf Rich Text Format
festgelegt wurde.
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18. Klicken Sie auf die Schaltfläche Run
(Ausführen), um die Messungen
auszuführen.
Nachdem Sie auf „Run“ (Ausführen)
geklickt haben, wird die Ergebnisseite für
die erste ausgewählte Messung auf dem
VM5000 angezeigt, und die Messungen
beginnen. Die angezeigte Zeilennummer
wird mit jeder abgeschlossenen
Messung größer, bis die Messung für alle
angegebenen Zeilen ausgeführt wurde.
Der Vorgang wird für jede ausgewählte
Messung wiederholt.

19. Um die Messergebnisse anzuzeigen,
öffnen Sie die Berichtsdatei mit der
entsprechenenden Anwendung.
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Anzeigen des Eingangssignals als Bild
Mit dem VM5000 kann das Eingangssignal als Bild angezeigt werden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application
> VM5000 HD and SD Video
oder VM5000 VGA Video (Datei >
Anwendung ausführen > VM5000 HD
und SD Video bzw. VM5000 VGA Video)
aus.

3. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)

4. Klicken Sie auf die Schaltfläche
mit dem Bild. Daraufhin wird das
Videomonitorfenster angezeigt.
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5. Klicken Sie auf die Schaltfläche zum
Maximieren, um das Bild auf den
gesamten Bildschirm zu vergrößern.

Option SD/HD

Option VGA
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Anzeige des Eingangssignals in einem Vektorskop-Fenster – Nur Optionen
SD/HD

Mit dem VM5000 kann das Eingangssignal in einem Vektorskop-Fenster angezeigt werden, sodass Sie sofort den
Farbbereich des Signals sehen können.

1. Schalten Sie das Gerät ein.

2. Wählen Sie File > Run Application >
VM5000 HD and SD Video (Datei >
Anwendung ausführen > VM5000 HD
und SD Video) aus.

3. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 8, Verbinden von
Eingangssignalen.)
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4. Klicken Sie auf die Schaltfläche
„Vectorscope“ (Vektorskop).
Daraufhin wird das Videomonitor-
Anzeigefenster angezeigt.

5. Klicken Sie auf die Schaltfläche zum
Maximieren, um die Vektorskopanzeige
auf den gesamten Bildschirm zu
vergrößern.
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